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End User Migration Instructions 
INTUIT QUICKEN (WINDOWS/MAC) / QUICKEN & QUICKBOOKS 

 
 
As The Bank of Kentucky completes a system migration, you will need to modify certain 
information in your Quicken/QuickBooks software to ensure a smooth transition of your 
data. You must complete the following steps after the conversion date: 2-28-2008.  
 
It is important that you perform the following instructions exactly as described and in the 
order presented. If you do not, your PFM Banking service may stop functioning properly. 
 
If you have any questions regarding these instructions, please contact Patti McDermott at 
859-372-9754 to assist you from 9:00 a.m. to 5:00 p.m. EST Monday – Friday.  
 
Select your software version from this index to access instructions for your 
online accounts within Quicken (WIN/MAC) / QUICKEN & QUICKBOOKS. 
 
 

Quicken Windows 2007 - 2008 
Quicken Windows 2005-2006 

Quicken MAC 2007-2008 
Quicken MAC 2005-2006 

QuickBooks 2008 
QuickBooks 2006 - 2007 

QuickBooks 2005 
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Quicken Windows 2007-2008 Instructions 
 
 

STEP A.  INSTALL THE LATEST QUICKEN UPDATE 

 
Follow the steps in this section to determine if a Quicken update is available 
and to download the update. 
 

1. From the Quicken Online menu, choose One Step Update. 
2. Uncheck all options in the One Step Update dialog boxes and click Update 

Now. 
3. If an update is available, apply it now. 
4. Exit and restart Quicken. 

 
For more information, see http://www.intuit.com/support/quicken/updates/. 
 
 

 

STEP B.  BACK UP YOUR CURRENT QUICKEN DATA 

 
From the Quicken File menu, choose Backup, enter information, as needed in 
the Quicken Backup dialog boxes, and then click OK.   
 
Do not restore to any earlier backups after you complete these instructions. 
 
 

STEP C.  DEACTIVATE YOUR ACCOUNTS 

 
 

1. Open the register for the first account at The Bank of Kentucky. 
2. Click the Overview tab. 
3. Before you continue, it is important that you record your account information. 

From this window you will see your Account Number, Routing Number, and 
Customer ID.  Write this information down so you have it later, or choose 
File, Print Overview. 

4. In the Account Attributes area, click Change Online Services. 
5. Click Remove from One Step Update in the One Step Update. 
6. Click Yes when the “Would you like to deactivate this service?” message 

appears 
7. Click Yes to continue and then OK 
8. Repeat steps 1-7 for all accounts enabled for online access. 
9. To ensure all online accounts have been disabled, go to the Tools menu, 

Account List and verify the word ‘Activated’ does not appear in the Online 
Services column for all your The Bank of Kentucky accounts.  Close this screen 
by clicking the ‘X’ on the top right corner of this page. 
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STEP D.  REACTIVATE YOUR ACCOUNT(S) 

 
 

1. Open the register for the first account at The Bank of Kentucky 
2. Click the Overview tab 
3. In the account attributes area, click Change Online Services. 
4. Click the Online Services tab. 
5. To activate Transaction Download, click Activate One Step Update in the One 

Step Update area.  
6. Enter the Direct Connect User ID and PIN and click Next. Follow the 

instructions to match the existing account and add new accounts, as applicable. 
7. If you have more than 6 six accounts, repeat steps 1-6 for each additional set 

of 6 accounts used for online services.  
 

If you use the Quicken PIN Vault, update it now.  
If you use the Quicken PIN Vault, you will need to re-add your PIN for The Bank 
of Kentucky. 
 

1. From the Quicken Online menu, choose Password Vault and then choose 
Edit. 

2. In the PIN Vault Password dialog box, enter your PIN Vault Password and then 
click OK. 

3. Select the User ID at The Bank of Kentucky and click Add Password 
4. In the “Add a Password” dialog box, enter your The Bank of Kentucky PIN, re-

enter your The Bank of Kentucky PIN, and then click Add. 
5. Click Done. 

 
 

 

STEP E.  GO ONLINE 

 
 

1. From the Quicken Online menu, choose Online Center.  
2. In the Online Center window, click Update/Send.  
3. Click Update Now to continue and then wait until your online session is 

completed 
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Quicken Windows 2005 - 2006 Instructions 
 
 

STEP A.  INSTALL THE LATEST QUICKEN UPDATE 

 
Follow the steps in this section to determine if a Quicken update is available 
and to download the update. 
 

1. From the Quicken Online menu, choose One Step Update. 
2. Uncheck all options in the One Step Update dialog boxes and click Update 

Now. 
3. If an update is available, apply it now. 
4. Exit and restart Quicken. 

 
For more information, see http://www.intuit.com/support/quicken/updates/. 
 
 

 

STEP B.  BACK UP YOUR CURRENT QUICKEN DATA 

 
From the Quicken File menu, choose Backup, enter information, as needed in 
the Quicken Backup dialog boxes, and then click OK.   
 
Do not restore to any earlier backups after you complete these instructions. 
 
 

STEP C.  DEACTIVATE YOUR ACCOUNTS 

 
 

1. Open the register for the first account at The Bank of Kentucky. 
2. Click the Overview tab. 
3. Before you continue, it is important that you record your account information. 

From this window you will see your Account Number, Routing Number, and 
Customer ID.  Write this information down so you have it later, or choose 
File, Print Overview (2006/2005) or Print Page (2004). 

4. In the Account Attributes area, click Change Online Services. 
5. Click Deactivate in the Transaction Download area and then click Yes in the 

pop-up dialog box to confirm. 
You will receive the message: “You are about to delete setup information for an 
online account.”  Click OK.  Click OK again. 

6. Repeat steps 1-5 for all accounts enabled for online access. 
7. To ensure all online accounts have been disabled, go to the Tools menu, 

Account List and verify the word ‘Activated’ does not appear in the Online 
Services column for all your The Bank of Kentucky accounts.  Close this screen 
by clicking the ‘X’ on the top right corner of this page. 
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STEP D.  REACTIVATE YOUR ACCOUNT(S) 

 
 

1. Open the register for the first account at The Bank of Kentucky 
2. Click the Overview tab 
3. In the account attributes area, click Edit Account Details. 
4. Click the Online Services tab. 
5. To activate Transaction Download, click Activate in the Transaction Download 

area. Enter the Direct Connect User ID and PIN and click Next. Follow the in-
screen instructions to match the existing account and add new accounts, as 
applicable. 

6. If you have more than six accounts, repeat steps 1-5 for each additional set of 
6 accounts that use online services.  

 

If you use the Quicken PIN Vault, update it now.  
If you use the Quicken PIN Vault, you will need to re-add your PIN for The Bank 
of Kentucky. 
 

1. From the Quicken Online menu, choose PIN Vault and then choose Edit. 
2. In the PIN Vault Password dialog box, enter your PIN Vault Password and then 

click OK. 
3. Select your first account at The Bank of Kentucky by clicking the account 

number.  
4. Click Add PIN. 
5. In the Change A PIN dialog box, enter your The Bank of Kentucky PIN, re-enter 

your The Bank of Kentucky PIN, and then click Add. 
6. Click Done. 
7. Repeat steps 3 – 6 for each account at The Bank of Kentucky 

 
 

 

STEP E.  GO ONLINE 

 
 

1. From the Quicken Cash Flow menu, choose Online Center.  
2. In the Online Center window, click Update/Send.  
3. Click Update Now to continue and then wait until your online session is 

completed 
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Quicken MAC 2007-2008 Instructions 
 

 

STEP A  INSTALL THE LATEST QUICKEN 2007 UPDATE 

 
1. From the Quicken 2007 menu, choose Check for Updates. 
2. If an update is available, you will be prompted to go to 

http://www.intuit.com/support/quicken/updates and follow the instructions to 
update to the latest version of Quicken.  

3. Quit and restart Quicken. 
  

STEP B  BACK UP YOUR CURRENT QUICKEN DATA 

 
From the File menu, choose Save a Copy, and then click OK.   

 

STEP C  DEACTIVATE YOUR ACCOUNTS  

Note: All transactions must be accepted in the account register before 
accounts can be deactivated.  

 
1. From the Lists menu, select Accounts. 
2. Select the account you want to disable and click Edit. This will open the Edit 

Account sheet.  
3. In the Download transactions dropdown menu, select not enabled. You will 

receive the message: “You are about to disable online services for this account 
within Quicken.”  Click OK.  

4. To save these changes click OK at the bottom of the Edit Account sheet.  
5. Repeat steps 1-4 for all accounts you have enabled for online access. 
6. To ensure all your online accounts have been disabled, go to the Lists menu, 

select Accounts and verify the blue globe does not appear next to any of your 
accounts.   

7. Close and reopen Quicken MAC. 
 
 

STEP D  
REACTIVATE YOUR ACCOUNTS 

 

 
1. From the Lists menu, select Accounts. 
2. Select the account you just disabled and click Edit. This will open the Edit 

Account sheet. 
3. Select using direct connect in the Download transactions dropdown menu.  
4. Click OK to save your changes to this account.  
5. Repeat steps 1-6 for every account.   

 
If you use the Quicken PIN Vault, you will need to update your The 
Bank of Kentucky PIN. 
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1. From the Quicken Online menu, choose PIN Vault. 
2. In the PIN Vault tab, select The Bank of Kentucky and click Edit.  
3. In the Change PIN sheet, enter your The Bank of Kentucky PIN, and re-enter 

your The Bank of Kentucky PIN, and then click OK. 
 
 
 

STEP E  GO ONLINE 

 
 

1. From the Quicken Online menu, choose One Step Update 
2. Click on Enter PIN.  
3. Enter the Direct Connect PIN and click OK and then Update Now 
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Quicken MAC 2005-2006 Instructions 
 

 

STEP A  INSTALL THE LATEST QUICKEN 2005/2006 UPDATE 

 
1. From the Quicken 2005/2006 menu, choose Check for Updates. 
2. If an update is available, you will be prompted to go to 

http://www.intuit.com/support/quicken/updates and follow the instructions to 
update to the latest version of Quicken.  

3. Quit and restart Quicken. 
  

STEP B  BACK UP YOUR CURRENT QUICKEN DATA 

 
From the File menu, choose Save a Copy, and then click OK.   

 

STEP C  DEACTIVATE YOUR ACCOUNTS  

Note: All transactions must be accepted in the account register before 
accounts can be deactivated.  

 
1. From the Lists menu, select Accounts. 
2. Select the account you want to disable and click Edit. This will open the Edit 

Account sheet.  
3. In the Download transactions popup, select not enabled. You will receive 

the message: “You are about to disable online services for this account within 
Quicken.”  Click OK.  

4. To save these changes click OK at the bottom of the Edit Account sheet.  
5. Repeat steps 1-4 for all accounts you have enabled for online access. 
6. To ensure all your online accounts have been disabled, go to the Lists menu, 

select Accounts and verify the blue globe does not appear next to any of your 
accounts.   

7. Close and reopen Quicken MAC. 
 
 

STEP D  
REACTIVATE YOUR ACCOUNTS 

 

 
1. From the Lists menu, select Accounts. 
2. Select the account you just disabled and click Edit. This will open the Edit 

Account sheet. 
3. Select using direct connect in the Download transactions dropdown menu.  
4. Click OK to save your changes to this account.  
5. Repeat steps 1-6 for every account.   

 
If you use the Quicken PIN Vault, you will need to update your The 
Bank of Kentucky PIN. 
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1. From the Quicken Online menu, choose PIN Vault. 
2. In the PIN Vault tab, select The Bank of Kentucky and click Edit.  
3. In the Change PIN sheet, enter your The Bank of Kentucky PIN, and re-enter 

your The Bank of Kentucky PIN, and then click OK. 
 
 
 

STEP E  GO ONLINE 

 
 

1. From the Quicken Online menu, choose Download Transactions. Make sure that 
The Bank of Kentucky is selected from the Financial Institution popup. 

2. Click Download and enter your Direct Connect PIN when prompted.  
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QuickBooks 2008 Instructions 
 

 

STEP A.  INSTALL THE QUICKBOOKS UPDATE 

 
1. From the Help menu, select Update QuickBooks. 
2. Select Update Now and then Get Updates 

 
 

STEP B.  BACKUP YOUR CURRENT QUICKBOOKS DATA 

 
1. From the QuickBooks menu, choose File, Save Copy or Backup 
2. Select Backup Copy, and click Next. 
3. Follow the on screen instructions to back up the file.  

 
 

STEP C.  DEACTIVATE YOUR ACCOUNTS 

Note: All transactions must be added to the account register before 
deactivating accounts. 

 
1. From the Lists menu select Chart of Accounts. 
2. Select a The Bank of Kentucky online account.  Click the Account button, 

Select Edit Account. 
3. The Edit Account dialog box appears.  Click Online Services tab. 
4. QuickBooks displays the Online Services window.  Select Deactivate All 

Online Services and then Save & Close.  
5. QuickBooks displays a warning message informing you that you are about to 

delete online setup information for a QuickBooks online account.  Click OK  
6. Repeat steps 1 through 5 until all The Bank of Kentucky accounts have been 

disabled. 
7. CLOSE and REOPEN QuickBooks. 
 

 
 

STEP D.  REACTIVATE YOUR ACCOUNT(S) 

 
 

1. From the Banking menu, select Online Banking, and then Set Up 
Account for Online Services  

2. At the Select your QuickBooks account: dropdown menu, select an account 
and click Next 

3. Select The Bank of Kentucky from the dropdown menu and click Next 
4. Select Direct Connect and click Next 
5. Select I have my special QuickBooks online services The Bank of 

Kentucky PIN and click Next 
6. Enter Direct Connect Customer ID and password and click Sign In 
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7. Highlight the account and select Next 
8. Click Finish 
9. From the Banking menu, select Online Banking, and then Set Up 

Account for Online Services  
10. Click Yes to close all windows. 
11. Repeat steps 2-10 until all accounts have been activated 

 
 
 

STEP F.  GO ONLINE 

 
 

1. From the Banking menu, select Online Banking, and then Online 
Banking Center.   

2. The Online Banking Center appears.  Click Go Online.  Enter your PIN and 
click OK. 
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QuickBooks 2006-2007 Instructions 
 

 

STEP A.  INSTALL THE QUICKBOOKS UPDATE 

 
3. From the Help menu, select Update QuickBooks. 
4. Select Update Now and then Get Updates 

 
 

STEP B.  BACKUP YOUR CURRENT QUICKBOOKS DATA 

 
From the QuickBooks menu, choose File, Backup, and enter a new backup 
filename. 
 

 

STEP C.  DEACTIVATE YOUR ACCOUNTS 

Note: All transactions must be added to the account register before 
deactivating accounts. 

 
8. From the List menu select Chart of Accounts. 
9. Select a The Bank of Kentucky online account.  Click the Account button, 

Select Edit Account. 
10. The Edit Account dialog box appears.  Click Online Info tab. 
11. Write down the ROUTING NUMBER, ACCOUNT NUMBER, ACCOUNT TYPE, and 

CUSTOMER ID.  You will need this in a later step. 
12. QuickBooks displays the Online Info window.  Deselect Online Account 

Access.  Click OK. 
13. QuickBooks displays a warning message informing you that you are about to 

delete online setup information for a QuickBooks online account.  Click OK  
14. If QuickBooks displays a warning message asking you if you want to retain the 

online information associated with this account.  Click NO.   
15. Repeat steps 1 through 8 until all The Bank of Kentucky Accounts have been 

disabled. 
16. CLOSE and REOPEN QuickBooks. 
 

 
 

STEP D.  REACTIVATE YOUR ACCOUNT(S) 

 
 

12. From the Banking menu, select Online Banking, and then Online 
Banking Center  

13. At the prompt to set up accounts for online services, select Yes 
14. Click Yes to continue 
15. Click Enable Accounts tab.  Click Next.  Click Add Financial Institution 

button.  
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16. Select The Bank of Kentucky. Click the Done button and then OK.  
17. Click the dropdown arrow to the right of I would like to enter 

information for my accounts. 
18. Select The Bank of Kentucky.  Click Next. 
19. Select Yes I have my confirmation letter from The Bank of Kentucky. 

Click Next. 
20. Enter the Routing Number.  
21. Enter your Customer ID.   

 
[Insert information about the end user’s new Customer ID, if applicable.] 

 
22. Click Next.  Click the dropdown arrow to the right of Use my existing 

QuickBooks account. Select your QuickBooks online Account.  Click Next.   
23. Click the dropdown arrow to the right of The Bank of Kentucky Account 

Type. 
24. Select the correct account type for this account.   
25. Type your The Bank of Kentucky account number into the Account Number. 

 
26. Select online account access and click Next. 
27. Review the account information. 
28. If you have more accounts to enable, select Yes next to Do you wish to 

enable additional accounts? Click Next and repeat these steps until all 
The Bank of Kentucky Accounts have been enabled. 

29. If you do not have more accounts to enable, select No next to “Do you wish 
to enable additional accounts?”  Click Next. 

30. QuickBooks displays the Service Agreement.  Click OK. 
31. QuickBooks asks if you wish to enable accounts at another institution. 
32. Select No.  Click Next. 
33. QuickBooks displays a Congratulations screen.  Click Leave. 

 
 
 

STEP F.  GO ONLINE 

 
 

3. From the Banking menu, select Online Banking, and then Online 
Banking Center.   

4. The Online Banking Center appears.  Click Go Online.  Enter your PIN and 
click OK. 
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QuickBooks 2005 
 

 

STEP A.  INSTALL THE QUICKBOOKS UPDATE 

 
From the QuickBooks menu, choose File, Update QuickBooks. Follow update 
instructions. 
 
 

STEP B.  BACKUP YOUR CURRENT QUICKBOOKS DATA 

 
Back up your current QuickBooks data. From the QuickBooks menu, choose 
File, Backup, and enter a new backup filename. 
 

 

STEP C.  DEACTIVATE YOUR ACCOUNTS 

Note: All transactions must be added to the account register before 
deactivating accounts. 

 
1. Select Chart of Accounts from the List menu. 
2. Select a The Bank of Kentucky online account.  Click the Account button, 

Select Edit. 
3. The Edit Account dialog box appears.  Click Online Info tab. 
4. Write down the ROUTING NUMBER, ACCOUNT NUMBER, ACCOUNT TYPE, and 

CUSTOMER ID.  You will need this in a later step. 
5. QuickBooks displays the Online Info window.  Deselect Online Account 

Access.  Click OK. 
6. QuickBooks displays a warning message informing you that you are about to 

delete online setup information for a QuickBooks online account.  Click OK  
7. If QuickBooks displays a warning message asking you if you want to retain the 

online information associated with this account.  Click NO.   
8. CLOSE and REOPEN QuickBooks. 
9. Repeat steps 1 through 8 until all The Bank of Kentucky Accounts have been 

disabled. 
 

 
 

STEP D.  REACTIVATE YOUR ACCOUNT(S) 

 
 

1. Select Set Up Online Financial Services from the Banking menu. 
2. Select Set Up Account for Online Access.  Click Enable Accounts tab.  Click 

Next.  Click Add Financial Institution button.  
3. Select The Bank of Kentucky. Click the Done button and then OK. Click Add to 

QuickBooks button. Click Exit on the Browser bar. Click the dropdown arrow 
to the right of I would like to enter information for my accounts. 
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4. Select The Bank of Kentucky.  Click Next. 
5. Select Yes I have my confirmation letter from The Bank of Kentucky. Click 

Next. 
6. Enter the Routing Number.  
7. Enter your Customer ID.   

 
8. Click Next.  Click the dropdown arrow to the right of Use my existing 

QuickBooks account. 
9. Select your QuickBooks online Account.  Click Next.  Click the dropdown arrow 

to the right of The Bank of Kentucky Account Type. 
10. Select the correct account type for this account.  Type your The Bank of 

Kentucky account number into the Account Number. 
11. Select online account access and click Next. 
12. Review the account information. 
13. If you have more accounts to enable, select Yes next to Do you wish to 

enable additional accounts? Click Next and repeat these steps until all The 
Bank of Kentucky Accounts have been enabled. 

14. If you do not have more accounts to enable, select No next to “Do you wish to 
enable additional accounts?”  Click Next. 

15. QuickBooks displays the Service Agreement.  Click OK. 
16. QuickBooks asks if you wish to enable accounts at another institution. 
17. Select No.  Click Next. 
18. QuickBooks displays a Congratulations screen.  Click Leave. 

 
 
 

STEP F.  GO ONLINE 

 
 

1. From the Banking menu, select Online Banking Center  
2. The Online Banking Center appears.  Click Go Online.  Enter your PIN and click 

OK. 
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